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  Release Notes, QuickBooks SDK 14.0  (12/10/2020)  

 
Welcome to the QuickBooks Software Development Kit (SDK) Version 14.0. 

 

  IMPORTANT  

This software is designed for use with US editions of 
QuickBooks 2018(R16 and above), QuickBooks 2019(R14 and 
above), QuickBooks 2020(R10 and above), QuickBooks 
2021(R4 and above). In addition, selected features of this 
software can be used with US editions of QuickBooks 2002, 
through QuickBooks 2021 and certain Canadian and UK 
editions of QuickBooks (2008 and later). However, you cannot 
currently install and use QuickBooks for different countries on 
the same machine. 

 

Release Note History 
In order to see what changed, especially which field values, enums, and QBFC-related 
items changed from release to release, you need to take a look at the Release Notes for the 
periods you are interested in. Release Notes from SDK 3.0 to the current release can be 
found at the IPP website. 
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• “System Requirements” 
• “QuickBooks Products and qbXML/QBFC Support” 
• “If You Have Questions . . .” 

 

A Note About Credit Card Numbers in QB 2008 and Later 
Due to requirements of the payment card industry, QuickBooks 2008 and later will mask all 
credit card data returned from SDK requests. All responses that return credit card 
information will return only masked numbers, even in a customer query, when invoked 
against QuickBooks 2008 and later. 

 

What’s New in SDK 14.0? 
 

Overview 

Here is what’s new: 
• Added FormType (MISC / NEC) to Form1099CategoryAccountMappingMod, 

Form1099CategoryAccountMappingQuery and Form1099CategoryAccountMappingRet.  
Support for filing MISC and NEC form is provided in Form1099CategoryAccountMapping API 
where FormType can be used to distinguish the boxes for MISC and NEC type. 

• Added BOX15 to the Enum list in MappingCategory. 
• No impact on UK and Canadian version. SDK 14.0 has impact only on US versions. 
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QuickBooks 2011 Multi-Instance Implications with the SDK 
Multi-Instance is available only in QuickBooks Accountant 2011, QuickBooks Enterprise 
Solutions Accountant 11.0, QuickBooks Enterprise Solutions 11.0 editions and newer 
editions of these versions. Multi-Instance does not allow the same QuickBooks file to be 
open concurrently, it allows for two different QuickBooks files to be opened. The following 
features are not available in second instance: QuickBooks Messenger, payroll. The 
following features are unavailable in both instances: unlocking or purchasing additional 
features/seats, TurboTax integration, Intuit Data Services setup, applications that use the 
Intuit Software Development Kit (SDK) to communicate with QuickBooks. The following 
features are available in one of the two instances: multi-user mode, file hosting, 
QuickBooks Help and Live Community. Other features not listed above are impacted and 
additional restrictions apply in either the first instance, second instance or both instances; 
See  https://accountants.intuit.com/accounting/quickbooks/multi-instance-restrictions/ for a 
list of restrictions. 

 
 

Request/Field-Level Detail of New and Changed Features 
The following table lists the changed behavior and/or fields for each SDK request, with corresponding changes to 
the response/ret objects: 

 

Object Operation Changes 
Form1099CategoryAccountMapping Query, Mod, Ret Added FormType. 

Added BOX15 to MappingCategory.  
Removed Box14 support from MappingCategory. 

http://www.accountant.intuit.com/mi
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 Changes Impacting QBFC Integrations 
There are known changes that will break existing applications recompiled with QBFC14: 

• The Form1099CategoryAccountMappingQuery has changed in QBFC14: The form type (a 
STRTYPE) has been added as an element which is used to distinguish between form types (“MISC” 
or “NEC”).  

 
• The Form1099CategoryAccountMappingMod has changed in QBFC14: The form type 

(a STRTYPE) has been added as an element which is used to distinguish between form 
types (“MISC” or “NEC”). 

 
• The Form1099CategoryAccountMappingRet has changed in QBFC14: The form type (a 

STRTYPE) has been added as an element which is used to distinguish between form 
types (“MISC” or “NEC”). 

 
• BOX15 has been added to the ENUM values of MappingCategory. 

 

Bugs Fixed in This Release 
The following table lists the bug fixes by the SDK request. 

 

SDK Request Bug and nature of Fix 
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Known Bugs and Workarounds 
The following table documents known behavior quirks as well as known issues and any 
workarounds for them. 

 

Issue Workaound 
ItemSalesTaxRef node in CustomerAdd is not 
supported for Canada edition - QBW059046 

 

In the sample 
\samples\qbdt\cpp\qbxml\hostquery, you may get 
a build failure when you try to build the sample, 
due to a problem with the Interop.QbxmlRP2 
reference. 

If you get this error, simply go to the project 
properties, click on the .Net tab and remove the 
reference to Interop.QBXMLRP2. Re-add the 
reference to it and rebuild the hostquery sample. It 
should build properly. 

If you use qbXML rather than QBFC, notice that 
the new 7.0 request AccountTaxLineInfoQuery 
does not work if issued in the following XML 
format: 
<AccountTaxLineInfoQueryRq> 
</AccountTaxLineInfoQueryRq> 

Use this format instead: 
<AccountTaxLineInfoQueryRq /> 
QBFC7 does use the above format, so you won’t need 
to worry about this issue if you use QBFC. 

For international QuickBooks 2008 and 2009 
versions, it is not possible ItemSalesTaxAdd or 
ItemSalesTaxGroupAdd 

 

Adding menu items (ui extension events) to QB 
when using Vista 

After you subscribe your menu extension events and 
register them as documented, you need to run QB 
using "Run As Administrator." This only has to be 
done ONCE, after running QB as admin once, your 
menu items will continue to show up and menu 
events will be received by your event handler without 
running QB as admin. 

A CustomerQuery may contain different results 
(sort order) when run against QB 2008 and 
greater than the same query running against QB 
2007 and earlier. This difference in sort order may 
be observed if you use MaxReturned set to a 
numeric value or if the query response contains 
the ampersand character & or apostrophe ‘ in the 
<name> field. 

 

In the Microsoft Vista OS, the path c:\documents 
and settings\all users\ used in Windows XP is 
translated to the path c:\users\public\. If a 
company file in QuickBooks is opened on Vista 
with the path "c:\documents and settings\all 
users..." and that filename is also specified with 
the same path in an SDK integrated application, 
the SDK response says that QuickBooks is already 
open with a different file. As per the following: "- 
2147220470 A QuickBooks company data file is 
already open and it is different from the one 
requested." 
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Issue Workaound 
Developers may be accustomed to using the 
common file open dialog to allow the user to 
browse to a file (for example, the select a 
company file dialog in SDKTestPlus3.exe) 
Unfortunately, Microsoft changed the behavior of 
this dialog in Vista so it actually attempts to OPEN 
the file before returning control to the app that 
called it. 
The result is that if QB has the file open (or, more 
accurately, the QB database server has the file 
open) you get an error from the dialog that the file 
is locked and you cannot use it. 

Here is how to handle this: 
1. In the application’s first connection do a 
BeginSession and invoke GetCurrentFilename and 
save it away for future use, or display to the user, or 
whatever. 
2. In all subsequent connections invoke BeginSession 
using that stored company file name. 
If the application gets an error that it cannot open 
the file, invoke BeginSession again, invoke 
GetCurrentFilename, compare against the stored file 
name and ask user about it if they don’t match. 

During installation of QB SDK on a system without 
QuickBooks installed you may encounter this error 
during the execution of dotnetfxSp1.exe: 
“The upgrade patch cannot be installed by the 
Windows Installer service because the program to 
be upgraded may be missing, or the upgrade patch 
may update a different version of the program. 
Verify that the program to be upgraded exists on 
your computer and that you have the correct 
upgrade patch.” 

To solve this, install .NET from the Microsoft web site 
and retry the installation. 

During SDK installation, you may see a message 
informing you that the UI and eBay sample could 
not be installed. 

You can safely ignore and dismiss this message as it 
has no effect and the installation will proceed 
successfully. 

In a VehicleMileageQuery, if you specify time 
values (for example, 2002-06-05T10:21:10) in 
any of the date range filters, you get a status code 
error 3020 statusSeverity="Error" 
statusMessage="There was an error when 
converting the date value...” 

The reason for this is that Vehicle Mileage supports 
only Date values, not DateTime values, despite what 
the OSR says. The workaround is to use only date 
values, as follows: 2002-06-05. 

If you use DeliveryPolicy in both a 
DataEventSubscription and a UIEventSubscription, 
you could set one to DeliverAlways and the other 
to DeliverOnlyIfRunning. In that case, QB will 
cache your application’s COM pointer if the first 
event for this application in a company file session 
is associated with the DeliverAlways policy. 

 

If a user installs a copy of Convertible QuickBooks 
2006 or greater but does not select one of the 
available editions (Premier, Accountant, Contractor 
edition, etc), and an SDK application is 
subsequently started, QuickBooks will prompt the 
user to select an edition. The application’s call to 
BeginSession will fail while QuickBooks is being 
configured for the selected edition. 

The workaround is to have the user finish the process 
of selecting the desired edition and then restart the 
SDK application. 

QuickBooks Canada does not return values stored 
in the Company Data Extension fields. The bug 
affects QuickBooks Canada versions 2004 through 
2007 and may affect QuickBooks UK versions 2004 
through 2006. 
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Issue Workaound 
The order of some columns in reports may be 
different in QuickBooks 2008 than they were for 
older versions of QuickBooks. 

This is not a bug, just a heads-up: the SDK 
documentation has always warned about assuming 
any column order. 

QuickBooks caches the latest Refnumber for each 
transaction type. If you try to save a transaction 
using the default Refnumber from the UI, the UI 
will warn you if someone else already saved 
transaction with the same refnumber and give you 
the opportunity to change it to the new latest 
Refnumber. In the SDK, it simply gets used and 
you wind up with two transactions with the same 
refnumber 

 

In QuickBooks Simple Start edition, it is possible 
for an SDK application to create a subitem for a 
given item. It is not possible to do this in the UI, 
because the UI for creating items does not allow a 
subitem to be specified. You should avoid doing 
this in your application when running against 
Simple Start. 

 

If QuickBooks Verify is running and an SDK 
application issues a request, the request will not 
complete until the verify finishes. 

 

If QuickBooks 2007 and later is running non 
hosted, SDK applications starting QuickBooks in 
DoNotCare mode will open QuickBooks in single- 
user mode. 

 

 

New or Modified Files of Interest 
This release includes documentation, tools, and samples. The following files and directories 
may be of particular interest to you: 

• This release includes .NET Primary Interop Assemblies (PIAs) for QBXMLRP2, 
QBFC14 and QBFC13. These assemblies are included in the redistributable installers 
and merge modules for each library. If you have previously built a local interop 
assembly for use with your .NET integrations, please be sure to update them to use the 
primary interop assemblies included with this release instead. QBFC13, QBFC12, 
QBFC11, QBFC10, QBFC8, QBFC7, QBFC6, QBFC5, QBFC4, QBFC3, and 
QBFC2.1 are available at 
https://developer.intuit.com/app/developer/qbdesktop/docs/get-started/older-versions-
of-the-desktop-sdk  

• doc\qbxmlops140.xml and doc\qbxmlso140.xml 
The sample files containing all qbXML requests/responses, and their SignonMsgs 
requests and responses.

https://developer.intuit.com/app/developer/qbdesktop/docs/get-started/older-versions-of-the-desktop-sdk
https://developer.intuit.com/app/developer/qbdesktop/docs/get-started/older-versions-of-the-desktop-sdk
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All samples require the QBXMLRP2 Request Processor, QuickBooks, and the QuickBooks 
sample product-based company file. Samples new in this release may require the latest 
QuickBooks version (currently QuickBooks 2021). The QBXMLRP2 Request Processor is 
installed automatically by QuickBooks 2021. 

 

Installation Instructions 
 

  IMPORTANT  

During SDK installation, if the eBay SDK has previously been 
installed on your system, the SDK installer may report a 
failure registering ebay.SDK.tlb. This error can safely be 
ignored and the installation will proceed normally. 

To install the SDK using the installer, execute QBSDK140.exe. The installer also adds a 
menu (Start>Programs>Intuit SDKs>QuickBooks SDK 14.0>) that provides convenient 
access to SDK tools, samples, and documentation. You can also access the qbXML 
Validator and qbXML Test applications through the "Send To" context menu for files. 

 
Installing on a System that Doesn’t Have QuickBooks 

During installation of QB SDK on a system without QuickBooks installed you may 
encounter this error during the execution of dotnetfxSp1.exe: 

 
“The upgrade patch cannot be installed by the Windows Installer service because the 
program to be upgraded may be missing, or the upgrade patch may update a different 
version of the program. Verify that the program to be upgraded exists on your computer and 
that you have the correct upgrade patch.” 

To solve this, install .NET from the Microsoft web site and retry the installation. 
 

Importing the Correct Library 
For Visual C++ applications (if you are not using the QBFC Library), you need to import 
the library named qbxmlrp2.dll, which is installed in C:\Program Files\Common 
Files\Intuit\QuickBooks. For Visual Basic applications, select Project > References from 
within your VB project. Find “QBXMLRP2 1.0 Type Library” in the list and check the box 
next to it, then click OK. If you don’t find the entry in the list, you can browse to it. 

 

About Redistributing QBXMLRP2 
Previous to SDK 7.0, we recommended redistributing QBXMLRP2. Beginning with SDK 
7.0, we recommend that you do NOT redistribute QBXMLRP2 except in the following two 
cases: 
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• Your application needs to support QuickBooks versions older than QB 2004. 
• Your application runs against versions of QuickBooks older than QB 2005 but needs 

certain advanced features of the request processor, such as AuthFlags. 
 

If either of these apply to your case, you can redistribute QBXMLRP2 by manually 
including the merge module QBXMLRP2.msm or QBXMLRP2PIA.msm (for .Net 
applications) 

 

Creating Applications that Can Run on 64-Bit Operating Systems 
If you want your SDK application to run on a 64-bit machine, and are using Visual Studio 
to develop it, you must have the compiler options set properly. In particular, you must set 
the Platform Target to x86. 

 
This has caused some developers problems, because the default setting if you simply create 
a new project is “Any CPU”, which is a setting that has prevented some developer 
applications from running on 64-bit OS. 

 

Documentation 
This release updates the QuickBooks Web Connector Programmer’s Guide, which 
describes how to develop web services that work with the QuickBooks web connector. The 
other documents are updated versions of previous documents: t the QB SDK Programmer’s 
Guide is a comprehensive treatment of QB SDK programming, and the Technical Overview 
provides a high level overview of the functionality provided in SDK. All documents are 
available in PDF. 

 

Tools 

 
The qbXML Validator tool contains new functionality that allows you to verify qbXML 
requests that correspond to these combinations: 

• qbXML 14.0, 13.0, 12.0, 11.0, 10.0, 9.0, 8.0, 7.0, 6.0, 5.0, 4.1, 4.0, 3.0, 2.1, 2.0, 1.1, 1.0 
for 
U.S. editions of QuickBooks and 2008-current UK and Canadian Editions 

• qbXML 9.0, 8.0, 7.0, 6.0 for 2008 - Newer UK and Canadian Editions using U.S. 
setting 

• qbmsXML 3.0 for QuickBooks Merchant Service 
• qbXML CA3.0 and CA2.0 for Canadian editions of QuickBooks (2004-2007 CA) 
• qbXML UK3.0 and UK2.0 for UK editions of QuickBooks (2004-2006 UK) 
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The Validator is installed automatically as part of the SDK installation. 
 

The file tools\SDKTest\SDKTestPlus3.exe is an enhanced version of SDKTest that uses 
QBXMLRP2 and allows the user to control every aspect of the connection to QuickBooks 
and can be used to send XML request files to QuickBooks. It supports sending subscription 
request XML as well as data integration XML. The source code for this tool is in 
samples\qbdt\vb\qbxml\SDKTestPlus3. 

The file tools\SubscriptionManager\SubView.exe is a tool for viewing and removing 
application subscriptions from QuickBooks. 

 

Samples 
 

The Samples directory contains a readme.html (which can be accessed from 
Start>Programs>Intuit SDKs>QuickBooks SDK X.0 > Samples). This file lists each 
sample and provides links to open the project directory, the project itself, and the 
executable form of the application. 

 
The SDK installer verifies that the MSXML4.0SP2 or greater API from Microsoft is 
installed on your system. If MSXML is not present, the SDK installer will install it for you. 
This API is used by the SDK’s Validator tool and several samples. 

Some samples require .NET 2.0. This can be downloaded from the Microsoft website. 
 

New Samples 

A new sample, MCInvoiceAdd, has been added to show the use of the new multicurrency 
feature. It is located in your SDK install subdirectory QBSDK14.0\samples\qbdt\c- 
sharp\qbXML. 

 
Downloading MSXML 6.0 

If you want to run the sample applications on a system that does not have MSXML 
installed (for example, if you want to use Remote Data Sharing from a system that does not 
have the SDK installed), you will need to install MSXML. In addition, if your application is 
dependent on MSXML Core Services, you will need to redistribute that software in your 
installer. The MSXML Core Services software is available from Microsoft 

 
Building the C++ Samples 

The #import “qbxmlrp2.dll” statement in the C++ samples allows these applications to use 
the COM interface supported by the QuickBooks SDK. This statement will cause an error 
when you are building the samples in Microsoft Visual Studio if the Include path is not set 
to include the location of this DLL. The DLL is installed with QuickBooks and resides in 
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http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en
http://msdn.microsoft.com/
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the QuickBooks common directory, currently defined as 
C:\Program Files\Common Files\Intuit\QuickBooks. Add this directory to the Include path 
by choosing the Tools menu, Options command, and the Directories tab in Visual Studio. 

 
 

UIandEventTest Samples 

In order to build the EventHandler C++ sample, you will need to specify the QuickBooks 
executable path for the sample project. The method for doing this is different for Visual 
Studio 6.0 and Visual Studio .NET. 

 
For Visual Studio 6.0, select "Options" from the "Tools" menu. Select the "Directories" tab 
and then select "Executable Files". Add the QuickBooks executable path to the list of 
directories here. 

 
For Visual Studio .NET, select "Properties" from the "Project" menu. Under the "C/C++" 
options, select "General" and add the QuickBooks executable path to the "Additional 
Include Directories". Under the "MIDL" options, also select "General" and add the QB path 
to "Additional Include Directories". 

 
All of these C++ samples also use QBXMLRP2.DLL in the QuickBooks "common" 
directory. The project files currently specify this path as C:\Program Files\Common 
Files\Intuit\QuickBooks. If this path is different on your machine, you will need to change it 
in the project files. 

 
Known Problems in VB Sample Applications 

The Visual Basic sample applications allow you to view a response from QuickBooks. If 
you try to view a response that is greater than 32K, you will receive an “Out of memory” 
error. This happens because the VB sample applications use a TextBox control, which has 
a 32K limit, rather than a RichTextBox control. In a Windows 98 or Windows Me 
environment, this can corrupt memory, and the application might not terminate properly. 

There is a known issue (not related to qbXML) with the AddReceivePayment sample 
application. The MS Visual Studio application must be installed before you can run 
AddReceivePayment, or you will receive the following error message when you run the 
application: “Class not registered. You need the following file to be installed on your 
machine. MSSTDFMT.DLL.” 

 
 

Using Payroll Reports 
If your application is accessing a company file that is currently signed up for a subscription 
to a payroll service, you can generate payroll reports and query PayrollNonWageItems. 
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To test this feature, you can use one of Intuit’s sample company files (even though it will 
not be signed up for a subscription to a payroll service). Please be aware that QuickBooks 
will record an artificial creation date to any test data that you add to a sample company file. 

 
 

Deprecation Policy 
You may notice that some items in the OSR are marked as deprecated. Deprecated items 
supported for the release in which they are deprecated, in the next major release they will 
be removed from the spec and their functionality will not be available. 

 

System Requirements 
The system requirements for the QuickBooks SDK are the same as those for the version of 
QuickBooks that is running. 

 

QuickBooks Products and qbXML/QBFC Support 
The following table of QuickBooks versions and supported qbXML and QBFC versions 
takes precedence over any other such tables in QB SDK documentation. 

 
The following table lists the different versions of QuickBooks and the corresponding 
versions of the qbXML specifications that support them. Note: QuickBooks Mac, 
QuickBooks Basic, UK Simple Start edition, UK regular editions, and the Canadian 
QuickBooks Easy Start Edition do not support the SDK. (For UK, use QuickBooks Pro and 
QuickBooks Accountant.) 
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Version of QuickBooks 

qbXML Specification 
Version 

QuickBooks 2018(R16 and above) and Enterprise18.0 
QuickBooks 2019(R14 and above) and Enterprise 19.0 
QuickBooks 2020(R10 and above) and Enterprise 20.0 
QuickBooks 2021(R4 and above) and Enterprise 21.0 
(Using QBXMLRP2) 

14.0,13.0,12.0,11.0,10.0,9.
0, 8.0,7.0 , 6.0, 5.0, 4.1, 
4.0,3.0,2.1,2.0, 1.1,1.0 

QuickBooks 2014 and Enterprise 14.0 (Using QBXMLRP2) 13.0,12.0,11.0,10.0,9.0,8.0 
through 
QuickBooks 2018(R15 and below) and Ent 18.0 
QuickBooks 2019(R13 and below) and Ent 19.0 
QB 2020(R9 and below) and Ent 20.0 
QB 2021(R3 and below) and Ent 21.0  

,7.0,6.0,5.0,4.1,4.0,3.0,2.1, 
2.0,1.1,1.0 

  
QuickBooks 2013 and Enterprise 13.0 (Using QBXMLRP2) 12.0,11.0,10.0,9.0,8.0,7.0, 

 6.0,5.0,4.1,4.0,3.0,2.1,2.0, 
 1.1,1.0 
QuickBooks 2012 and Enterprise 12.0 (Using QBXMLRP2) 11.0,10.0,9.0,8.0,7.0,6.0, 
 5.0,4.1,4.0,3.0,2.1,2.0,1.1, 
 1.0 
QuickBooks 2011 and Enterprise 11.0 (Using QBXMLRP2) 10.0,9.0,8.0,7.0,6.0,5.0,4.1 

4.0,3.0,2.1,2.0,1.1,1.0 
QuickBooks 2010 and Enterprise 10.0 (Using QBXMLRP2) 9.0,8.0,7.0, 6.0, 5.0, 4.1 

4.0, 3.0, 2.1, 2.0, 1.1, 1.0 
QuickBooks 2009 and Enterprise 9.0 (Using QBXMLRP2) 8.0,7.0, 6.0, 5.0, 4.1 4.0, 

3.0, 2.1, 2.0, 1.1, 1.0 
QuickBooks 2008 and Enterprise 8.0 (Using QBXMLRP2) 7.0, 6.0, 5.0, 4.1 4.0, 3.0, 

2.1, 2.0, 1.1, 1.0 
QuickBooks 2007 and Enterprise 7.0 (Using QBXMLRP2) 6.0, 5.0, 4.1 4.0, 3.0, 2.1, 

2.0, 1.1, 1.0 
QuickBooks 2006 and Enterprise 6.0 (Using QBXMLRP2) 5.0, 4.1 4.0, 3.0, 2.1, 2.0, 

1.1, 1.0 

QuickBooks 2005 and Enterprise 5.0 (R5 and later) 4.1, 4.0, 3.0, 2.1, 2.0, 1.1, 
(using QBXMLRP2) 1.0 
QuickBooks 2005 (and Enterprise 5.0) (using QBXMLRP2) 4.0, 3.0, 2.1, 2.0, 1.1, 1.0 
QuickBooks 2004 (and Enterprise 4.0) (using QBXMLRP2) 3.0, 2.1, 2.0, 1.1, 1.0 
QuickBooks 2003, Enterprise 3.0* (R7 and above) 

and all later versions of QuickBooks using QBXMLRP 
2.1, 2.0, 1.1, 1.0 

QuickBooks 2003 and Enterprise 2.0* 2.0, 1.1, 1.0 
QuickBooks 2002 (R2 and above) and Enterprise* 1.1, 1.0 
QuickBooks 2002 (R1)* 1.0 
 
QuickBooks 2018(R16 and above) Canadian  
QuickBooks 2019(R14 and above) Canadian 
QuickBooks 2020(R10 and above) Canadian 
QuickBooks 2021(R4 and above) Canadian 

14.0,13.0,12.0,11.0,10.0,9.
0, 8.0,7.0 , 6.0, 5.0, 4.1, 
4.0,3.0,2.1,2.0, 1.1,1.0 

QuickBooks 2014 Canadian 13.0,12.0,11.0, 10.0, 9.0, 
through 
QuickBooks 2018(R15 and below) Canadian 
QuickBooks 2019(R13 and below) Canadian  

8.0, 7.0, 6.0, 5.0, 4.1 4.0, 
3.0, 2.1, 2.0, 1.1, 1.0 
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QB 2020(R9 and below) Canadian 
QB 2021(R3 and below) Canadian 
  
QuickBooks 2013 Canadian 12.0,11.0, 10.0, 9.0, 8.0, 

 7.0, 6.0, 5.0, 4.1 4.0, 3.0, 
 2.1, 2.0, 1.1, 1.0 
QuickBooks 2012 Canadian 11.0, 10.0, 9.0, 8.0, 7.0, 

 6.0, 5.0, 4.1 4.0, 3.0, 2.1, 
 2.0, 1.1, 1.0 
QuickBooks 2011 Canadian 9.0, 8.0,7.0, 6.0, 5.0, 4.1 

4.0, 3.0, 2.1, 2.0, 1.1, 1.0 
QuickBooks 2010 Canadian 8.0,7.0, 6.0, 5.0, 4.1 4.0, 

3.0, 2.1, 2.0, 1.1, 1.0 
QuickBooks 2008-2009 Canadian 6.0 
QuickBooks 2018(R16 and above) UK  
QuickBooks 2019(R14 and above) UK 
QuickBooks 2020(R10 and above) UK 
QuickBooks 2021(R4 and above) UK 

14.0,13.0,12.0,11.0,1
0.0,9.0, 8.0,7.0 , 6.0, 
5.0, 4.1, 
4.0,3.0,2.1,2.0, 
1.1,1.0 

QuickBooks 2014 UK 
through 
QuickBooks 2018(R15 and below) UK 
QuickBooks 2019(R13 and below) UK 
QB 2020(R9 and below) UK 
QB 2021(R3 and below) UK 

13.0, 12.0, 11.0, 
10.0, 9.0, 
8.0, 7.0, 6.0, 5.0, 4.1 
4.0, 
3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2013 UK 12.0, 11.0, 10.0, 9.0, 
8.0, 
7.0, 6.0, 5.0, 4.1 4.0, 
3.0, 
2.1, 2.0, 1.1, 1.0 

QuickBooks 2012 UK 11.0, 10.0, 9.0, 8.0, 
7.0, 
6.0, 5.0, 4.1 4.0, 3.0, 
2.1, 
2.0, 1.1, 1.0 

QuickBooks 2010 UK 8.0,7.0, 6.0, 5.0, 4.1 
4.0, 
3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2008-2009 UK 6.0 
QuickBooks 2004-2007 Canadian 
(using QBXMLRP2) 

CA3.0, CA2.0 

QuickBooks 2004-2006 UK Editions 
(using QBXMLRP2) 

UK3.0, UK2.0 

QuickBooks 2003, Canadian and UK Editions, CA2.0. UK2.0)* and all 
later versions of these through QuickBooks 2006 

CA2.0. UK2.0 

*Earlier releases of QuickBooks will work with either version of the Request Processor (QBXMLRP2 or 
QBXMLRP). We recommend you upgrade existing applications to use QBXMLRP2. SDK 3.0 and greater features are avail- able 
only with QBXMLRP2; in addition, this Request Processor solves some problems found in the older Request Processor. 
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The following table lists the different versions of the QuickBooks Foundation Class (QBFC) Library and the 
versions of the qbXML specification that support them. 
 
 

QBFC Library qbXML Specification 
Version 

QBFC14 14.0,13.0,12.0,11.0,10.0,
9.0,8.0, 7.0, 6.0, 5.0, 4.1, 
4.0,3.0,2.1,2.0,1.1, 1.0 
Does NOT support: 
CA3.0,CA2.0,UK3.0, 

UK2.0 

QBFC13 13.0,12.0,11.0,10.0,9.0, 
8.0,7.0,6.0,5.0,4.1,4.0,3. 
0,2.1,2.0,1.1, 1.0 
Does NOT support: 
CA3.0,CA2.0,UK3.0, 
UK2.0 

QBFC12 12.0,11.0,10.0,9.0,8.0,7. 
0,6.0,5.0,4.1,4.0,3.0,2.1, 
2.0,1.1, 1.0 
Does NOT support: 
CA3.0,CA2.0,UK3.0, 
UK2.0 

QBFC11 11.0,10.0,9.0,8.0,7.0,6.0 
,5.0,4.1,4.0,3.0,2.1,2.0,1 
.1, 1.0 
Does NOT support: 
CA3.0,CA2.0,UK3.0, 
UK2.0 

QBFC10 10.0,9.0,8.0,7.0,6.0,5.0, 
4.1,4.0,3.0,2.1,2.0,1.1, 
1.0 
Does NOT support: 
CA3.0,CA2.0,UK3.0, 
UK2.0 

QBFC8 8.0,7.0,6.0,5.0,4.1,4.0, 
3.0,2.1,2.0,1.1,1.0 
Does NOT support: 
CA3.0, CA2.0, UK3.0, 
UK2.0 
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QBFC7 7.0, 6.0, 5.0, 4.1, 4.0, 
3.0, 2.1, 2.0, 1.1, 1.0 
Does NOT support: 
CA3.0, CA2.0, UK3.0, 
UK2.0 

 
 
 

QBFC6 6.0, 5.0, 4.1, 4.0, 3.0, 
2.1, 2.0, 1.1, 1.0 
Does NOT support: 
CA3.0, CA2.0, UK3.0, 
UK2.0 

QBFC5 
(including support for Canadian Editions of 
QuickBooks) 

5.0, 4.1, 4.0, 3.0, 2.1, 
2.0, 1.1, 1.0, CA3.0, 
CA2.0, UK3.0, UK2.0 

QBFC4 
(including support for Canadian Editions of 
QuickBooks) 

4.0, 3.0, 2.1, 2.0, 1.1, 
1.0, CA3.0, CA2.0 

QBFC3 
(including support for Canadian Editions of 
QuickBooks) 

3.0, 2.1, 2.0, 1.1, 1.0 

QBFC2_1 2.1, 2.0, 1.1, 1.0 
QBFC2 2.0, 1.1, 1.0 
QBFC2CA CA2.0 
QBFC 1.1, 1.0 
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If You Have Questions . . . 
For IDG and community support, please visit  https://help.developer.intuit.com/s/. 
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